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Abstract— The design and construction of earthquake resistant structures can counter the aspect of the earthquake hazard with effective application 
of engineering knowledge. Most seismic design codes today include the nonlinear response of a structure implicitly through ‘Response reduction 
factor’(R) by IS 1893 (Part I):2002.This factor allows a designer to use a linear elastic force-based design while accounting for non-linear behavior 
and deformation limits. Performance based seismic design method which is recent path of seismic assessment, both efficient and effective to avoid 
future earthquake losses.  
In this work, performance based seismic design of buildings by pushover analysis method in four different seismic zones II, III, IV and V studied. 
For analysis building models of G+12, G+16 and G+20 stories, plan rectangular shaped generated by a computer program SAP 2000(version 
19).In this present work attempt is made to study and obtained Response Reduction Factor in different zones II, III, IV and V. Also different 
parameters like displacement, drift, pushover curves, performance point and plastic hinge mechanism studied. 
 
Keywords-Static analysis, Moment curvature relationship, Pushover analysis, Response reduction factor (R). 
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I.  INTRODUCTION  
Earthquake engineering is a sector of civil engineering that 

deals with the mitigation of earthquake-induced damage on 
structures and the minimization of loss of  life “. During the last 
forty years this sector has advanced considerably due to the rapid 
developments of computers and computing, the improved 
experimental facilities, and the development of new methods of 
seismic design and assessment of structures. This advancement 
though has not been enough to resist the catastrophic 
consequences that earthquakes impose. However, it has led to 
some improvement of design and assessment procedures with a 
shift from traditional force-based procedures to displacement-
based procedures (Antoniou 2002), as inelastic displacements 
have been deemed to be more representative of different 
structural performance levels. The characterization of the 
various performance levels has led to performance-based 
earthquake engineering, the most recent path of seismic design 
and assessment. 

This chapter provides a short description of the nature of 
performance-based earthquake engineering and its goals in 
seismic assessment. The procedures that are recommended for 
seismic assessment purposes are briefly described and the 
theoretical background of the non-linear static pushover analysis 
method is described. 

II. PERFORMANCE- BASED EARTHQUAKE ENGINEERING 
It was suggested that performance goals should be defined in 

order to account for all the three factors, structural damage, loss 
of life and economic losses. An attempt to define in a clear 

manner the performance objectives. Structural Engineers 
Association of California, SEAOC Vision 2000 (1995) and the 
US National Earthquake Hazard Reduction Program Guidelines 
NEHRP (1997) recommended a different approach. 
Immediate Occupancy: No significant damage has occurred to 
structure, building may be used for intended purpose, and 
Nonstructural elements are secure. 
Life Safety: Significant damage to structural elements with 
substantial reduction in stiffness, Nonstructural elements are 
secured but may not function. Occupancy may be prevented until 
repairs can be instituted. 
Collapse Prevention: Substantial structural and nonstructural 
damage. Stiffness substantially little margin against collapse. 
Some falling debris hazards may have occurred. 
The NSP procedure normally called Pushover Analysis, POA, is 
a technique of performance based methodology tool for 
assessment and design in which a computer model of a structure 
is subjected to a predetermined lateral load pattern, which 
approximately represents the relative inertia forces generated at 
locations of substantial mass. The intensity of the load is 
increased, i.e. the structure is ‘pushed’, and the sequence of 
cracks, yielding, plastic hinge formations, and the load at which 
failure of the This incremental various structural components 
occurs is recorded as function of the increasing lateral load. 
Process continues until a predetermined displacement limit. 
Terms involved in pushover analysis 
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Capacity - The capacity usually refers to the strength at the 
yield point of the element on the structure’s capacity 
curve. 

Capacity curve – It is the plot of the total lateral force V, on 
a structure, against the lateral deflection d, of the roof 
of the structure. This is often referred to as pushover 
curve. 

Capacity spectrum – The capacity curve transformed from 
shear force vs roof displacement (V vs d) co-ordinates 
into special acceleration vs spectral displacement (Sa   
vs    Sd) co-ordinates called capacity spectrum. 

Demand – It is a representation of the earthquake ground 
motion or shaking that the building is subjected to. In 
nonlinear static analysis procedures, demand is 
represented by an estimation of the displacements or 
deformations that the structure is expected to undergo 

Performance point – The intersection of capacity spectrum 
with the appropriate demand spectrum in the capacity 
method 

Ductility - It is the ability of a structural component, 
element, or system to undergo both large deformations 
or several cycles of deformation beyond its yield point 
or elastic limit and maintain its strength without 
significant degradation or abrupt failure.  

Ductility demand - It refers to the extent of deformation 
beyond the elastic limit. 

A. Seismic Zones of India 
Based on the levels of intensities sustained during damaging past 
earthquakes, the seismic zone map is revised with only four 
zones, instead of five. Erstwhile Zone I has been merged to Zone 
II. Hence, Zone I does not appear in the new zoning; only Zones 
II, III, IV and V.  

B.  Response Reduction Factor(R) 

Response reduction factor reflecting the capability of the 
structure to dissipate energy through inelastic behavior. This 
factor is  unique  and  different  for  different  type  of  structures  
and  materials  used.  It is given as 

R = Rs x Rμ x Rξ x RR     
Components of Response reduction factors are Strength factor 
(Rs) is obtained by dividing the maximum / ultimate base shear 
(Vu) by the design base shear (Vd). 
Ductility factor (Rµ) is a measured as ratio of ultimate or 
maximum base shear to base shear corresponding to yield. It is 
the capacity to undergo large inelastic deformation without 
significant loss of strength or stiffness, Rµ depends on time 
period. Rμ = 1   for zero-period structure, Rμ = √(2μ- 1) for short 
period structure, Rμ = μ,for long period structure, Rμ = 1+ (μ-1) 
T/0.7  (0.7 < T <0.3) .Where μ =  𝛥𝛥𝛥𝛥 𝛥𝛥𝛥𝛥�  . i.e the ratio of ultimate 
displacement and yield displacement.(Paulay and Priestley 
equation Rμ depends on time period). 
 Damping factor (Rξ) accounts for the effect of ‘added’ viscous 
damping, without devices, the damping factor is generally 
assigned a value equal to 1.0. Redundancy factor (RR) is 
measure of redundancy in a lateral load resisting system, 
depends on the structural system adopted. It is ASCE 7 
recommends a redundancy factor RR=1.0                

 

C. Moment Curvature Relationship (M-φ) in Pushover 
Analysis 
 
Moment curvature relationships are very important to find 

out ductility of the structure and the amount of possible 
redistribution of stresses.In pushover analysis status of damage 
is indicated by hinges formed in the frame elements. In order to 
define hinges, moment curvature relationship is used.Mander et 
al. (1988) have proposed a unified stress-strain approach for 
confined concrete that is applicable to both circular and 
rectilinear transverse reinforcement. The stress-strain curve is 
based on the equation proposed by Popovics (1973), in which 
the shape of the descending part of the curve depends upon the 
secant modulus at the peak point. 

 
Fig1:stress-strain model for confined and unconfined concrete – Manders 

(1988) model. 

III. OBJECTIVE OF STUDY 
1. To verify the designed R factor of most common 

engineer designed RC buildings and to obtain 
performance point of the buildings by comparing the 
assumed R factor during design to actual R factor 
obtained from non-linear analysis.  

2. To calculate strength factor, ductility factor, damping 
factor, redundancy factor for considered frame in all 
zones. 

3. To find out drift, displacement and base shear results of 
considered frame in all zones. 

4. To compare various analysis results of building under 
zone II,III,IV and V 

5. To obtain capacity curve for each building in both X 
and Y direction uses capacity spectrum method. 

6. To obtain performance point for each building. 
 

IV. PROBLEM STATEMENT 
In the present study for seismic performance of 12, 16 and 20 
storey reinforced concrete frames with the height 41.5m, 53.9m 
and 66.3m respectively are designed. In plan, horizontally four 
bays are at 3.2m and vertically three bays are at 4.8m.and in 
elevation floor height 3.1m and plinth 1.2m considered shown in 
Fig 2 
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Fig2:Elevation of frames considered 
 

Details of building geometry, material properties and load 
configurations 

Table 1: Building Details 
 

 
Table 2: Details of beams and columns of buildings 

 
Zone II Frame Members Floors Width Depth 

0.1 12 Storey Beam 1-12 250 400 
Column 1-8 250 600 

Column 9-12 250 500 

16 Storey Beam 1-16 250 400 

Column 1-10 250 700 

Column 11-16 250 600 

20 Storey Beam 1-20 250 400 

Column 1-5 250 900 

Column 6-12 250 700 

Column 13-20 250 500 

Zone III Frame Members Floors Width Depth 

0.16 12 Storey Beam 1-12 300 450 
Column 1-8 300 700 
Column 9-12 300 500 

16 Storey Beam 1-16 300 450 

Column 1-10 300 800 

Column 11-16 300 600 

20 Storey Beam 1-20 300 450 
Column 1-5 300 1000 

Column 6-12 300 800 
Column 13-20 300 600 

Zone IV Frame Members Floors Width Depth 

0.24 12 Storey Beam 1-12 300 450 

Column 1-8 300 700 

Column 9-12 300 500 

16 Storey Beam 1-16 300 450 
Column 1-10 300 800 

Column 11-16 300 600 

20 Storey Beam 1-20 300 450 

Column 1-5 300 1000 

Column 6-12 300 800 

Column 13-20 300 600 

Zone V Frame Members Floors Width Depth 

0.36 12 Storey Beam 1-12 350 550 

Column 1-8 350 800 

Column 9-12 350 700 

16 Storey Beam 1-16 400 550 
Column 1-10 400 1000 

Column 11-16 400 800 

20 Storey Beam 1-20 400 550 

Column 1-5 400 1200 

Column 6-12 400 1000 
Column 13-20 400 800 

 

V. PROCEDURE USED FOR NONLINEAR ANALYSIS IN SAP 
2000(V.19) 

1. Created model of considered RC framed 12, 16 and 20 
storey in computer program SAP2000 version 19. 

2. Define the static load cases, if any, that are needed for 
use in the static nonlinear analysis. 

3. Define hinge properties, if any (Define > Frame 
Nonlinear Hinge Properties command). 

4. Assign hinge properties, if any, to frame/line elements 
(Assign > Frame/Line > Frame Nonlinear Hinges 
command). 

5. Run the model for basic linear and dynamic analyses. 
(Analyze > Run Static Nonlinear Analysis command). 

6. Define the static nonlinear load cases (Define > Static 
Nonlinear/Pushover Cases command). 

7. Run the static nonlinear analysis (Analyze > Run Static 
Nonlinear Analysis command). 

8. Review the static nonlinear results (Display > Show 
Static Pushover Curve command), (Display > Show 
Deformed Shape command), (Display > Show Member 
Forces/Stress Diagram command), and (File > Print 
Tables > Analysis Output command).  

9. Perform any design checks that utilize static nonlinear 
cases. 

10. Revise the model as necessary and repeat.  

Description Salient Features 

Parameter ZONE II ZONE III ZONE 
IV 

ZONE V 

Seismic zone factor 0.10 0.16 0.24 0.36 
Building Shape Rectangle (plan  12.8 m X 14.4 m) 

Dead load(KN/M2)  
Floor Finish 1.5 1.5 1.5 1.5 
Internal wall 

150mm thick brick 
wall 

3 3 3 3 

External wall 
230mm thick brick 

wall 

4 4 4 4 

Response reduction 
factor 

5 5 5 5 

Importance factor 1 1 1 1 
Soil condition Medium Medium Medium Medium 

Live load(KN/M2)  
Residential floor 3 3 3 3 
Grade of concrete M25 M25 M25 M25 

Grade of Steel Fe415 Fe415 Fe415 Fe415 

http://www.ijritcc.org/


International Journal on Recent and Innovation Trends in Computing and Communication                                 ISSN: 2321-8169 
Volume: 6 Issue: 5                                                                                                                                                  262 – 267 
_______________________________________________________________________________________ 

265 
IJRITCC | May 2018, Available @ http://www.ijritcc.org                                                                 
_______________________________________________________________________________________ 

VI. RESULT 

 
 

Fig3: EQ-X Displacement graph for 12 storey 
 

Fig 3 shows the variation of displacement with respect to storey 
number for earthquake case in X direction at roof level of the 
building. Maximum values of displacement are 0.0216 m, 
0.0236 m, 0.0346 m, and 0.03549 m in Zone II, Zone III, Zone 
IV and Zone V respectively. 
 

 

Fig4: EQ-X Displacement graph for 16 storey 
 

Fig4 shows the variation of displacement with respect to storey 
number for earthquake case in X direction at roof level of the 
building. Maximum values of displacement are 0.0287 m, 
0.0320 m, 0.0393 m and 0.0380 m in Zone II, Zone III, Zone IV 
and Zone V respectively. 

 
Fig5: EQ-X Displacement graph for 20 storey 

 
Fig 5 shows the variation of displacement with respect to storey 
number for earthquake case in X direction at roof level of the 
building. Maximum values of displacement are 0.0367 m, 
0.0376 m, 0.050 m and 0.059 in Zone II, Zone III, Zone IV and 
Zone V respectively 

 
Fig6: EQ-X Drift graph for 12 storey 

Fig 6 shows inter storey drift is higher at 5th storey and then 
decrease till terrace floor. Drift increases Zone II to Zone V. 

 
Fig7: EQ-X Drift graph for 16 storey 

 
Fig 7 shows inter storey drift is higher at 6th storey and then 
decrease till terrace floor. Drift increases Zone II to Zone V. 

 

 
Fig8: EQ-X Drift graph for 20 storey 

 
Fig 8 shows inter storey drift is higher at 7th storey and then 
decrease till terrace floor. Drift increases Zone II to Zone V. 
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Fig9:Variations of Base Shear Values for different Zones 

 
Fig 9: shows the variation of base shear of G+12 building in 
Zone II, Zone III, Zone IV and Zone V. 
 

 

Fig10:Variations of Base Shear Values for different Zones 

Fig 10: shows the variation of base shear of G+16 building in 
Zone II, Zone III, Zone IV and Zone V. 
 

 
Fig11:Variations of Base Shear Values for different Zones 

 
Fig 11: shows the variation of base shear of G+20 building in 
Zone II, Zone III, Zone IV and Zone V. 
 
Calculated values of response reduction factor and it’s all 
components for buildings shown in following tables. 

 

 

 

Table3 - Results of response reduction factor for 12 storey 

 
Table4 - Results of response reduction factor for 16 storey 

16 Storey 
building  

Zone II Zone III Zone IV Zone V 

Time period 
(T) sec 

1.355 1.355 1.355 1.355 

Sa/g 1.003 1.003 1.003 1.003 
Rs 3.18 2.73 2.33 1.10 
Rμ 2.83 3.08 3.64 4.92 

RR 1 1 1 1 
Rξ 1 1 1 1 

R 8.99 8.40 8.49 5.41 

 
Table5 - Results of response reduction factor for 20 storey 

 

 

VII. CONCLUSION      
1. The base shear of structure increases as we go to higher 

seismic zones. For 12 storey building the base shear of 
Zone II is 409.9 kN and Zone V is 1749.94 kN. For 16 
storey building the base shear of Zone II is 401.14 kN 
and Zone V is 1846.133 kN and for 20 storey building 
the base shear of Zone II is 408.91 and Zone V is 
1891.54 kN. This means base shear increases by more 
than 430% if seismic Zone changes from II to V. 

2. The Displacement is very high at roof and very low at 
the base. For 12 storey building the displacement occur 
at the Zone II is 0.0216m and Zone V is 0.0354 
m.For16 storey building the displacement occur at 
Zone II is 0.0287 and Zone V is 0.0380 and for 20 
storey building displacement at Zone II is 0.0367 and 
Zone V is 0.059.This means displacement of building 
models increases with the increasing of seismic Zones. 

3. The storey drift is mainly occurred at the middle of the 
building structure. The maximum storey drift is 
available at 5th, 6th and 7th floor for 12, 16 and 20 
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12 Storey 
building 

Zone II Zone III Zone IV Zone V 

Time period 
(T) sec 

1.043 1.043 1.043 1.043 

Sa/g 1.303 1.303 1.303 1.303 
Rs 2.624 2.012 2.649 1.039 
Rμ 2.86 3.772 3.12 4.882 
RR 1 1 1 1 
Rξ 1 1 1 1 
R 7.51 7.58 8.26 5.07 

20 Storey 
building  

Zone II Zone III Zone IV Zone V 

Time period 
(T) sec 

1.67 1.67 1.67 1.67 

Sa/g 0.814 0.814 0.814 0.814 
Rs 3.87 2.03 2.4 1.07 
Rμ 2.73 3.25 3.06 4.68 

RR 1 1 1 1 
Rξ 1 1 1 1 
R 8.79 6.59 7.34 5.02 
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storey building respectively. As per result shown in 6.1, 
6.2 and 6.3 comparison graph for inter-storey drift in X 
and Y direction. The drift is increases by more than 
40% when compare to Zone II to Zone V, it is 
concluded that the storey drift increases with the 
increasing of seismic Zone factor. The maximum 
storey drift for all buildings is less than 0.4% of the 
building height, therefore IS 1893 part1-2002 clause 
no.7.11.1 is satisfied. 

4. As the height of the building increases, the time period 
of the building also increases. For 12 storey building, 
time period is less than 16 storey and 20 storey 
buildings. (As per Result shown in Table 3, Table 4 and 
Table 5). 

5. In pushover analysis, the values for the roof 
displacement and base shear capacity of the structure at 
the yield and ultimate levels are obtained and various 
components of the ‘R’ factor calculated, for estimating 
base shear, over strength factor, ductility factor and 
response reduction factor respectively. 

6. The response reduction factor is different for all 
buildings because of variation in, elevation of 
buildings, different materials properties, variation in 
strength and ductility of the building etc. (Table 3, 
Table 4 and Table 5). 

7. After performing pushover analysis if performance 
point is not obtained then to get that by using dampers 
or isolation, increasing strength or stiffness of the 
structure. 

8. Structure has significant impact of zones on the seismic 
response of structure in terms of displacement, storey 
drift, base shear and response reduction factor. 
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